
Name of the Candidate :

Name of the College :

NAME OF THE SUPERVISOR :

NAME OF THE COLLEGE :

YEAR OFSUBMISSION

2023



ACKNOWLEDGEMENT

Signature :



Annexure- IA

Supervisor's Certificate

COLLEGE: BANGABASI MORNING COLLEGE PLACE:
KOLKATA

Signature :

Annexure- IB

Student's Declaration

PLACE:
DUTTAPUK
UR

DATE:





Right Arrange theicononthe desktop a)by name,b)bysize,c)bydate,d)bytypeand
see the difference.

-click the desktop.

Point toArrangeIconsByand thenclickonofthe commandsonthesubmenu,
as explained in the tablebelow.

Click To

Name Arrange icons in alphabetical order by the icon name.

Size Arrange icons inorderoffile size. If the icon is a shortcut to a program,the
refers to the size of the shortcut file.

Type Arrangeiconsinorder oftype.Forexample,ifyouhaveshortcutstoseveral

Power point presentations on your desktop,

These will be arranged next to each other.

Date Arrange icons in the order that the shortcut was last modified.

Auto arranges the icons on desktop.

Right-click the desktop.

Pointtoarrange iconsby,andthenclickoneofthe commandsonthesubmenu,asexplained in
the tablebelow.

Move mouse pointer to edge ofthe taskbar pointer will change into double direction arrow
and then move this arrow upward this will widen the taskbar.

Move the task bar on the top of the desktop.

Click an empty area of the task bar and then drag it to the top of the desktop.

Move the taskbar on the bottom of the desktop.

Click an empty area of the taskbar and then drag it to bottom of the desktop again.

Arrange the icons in columns along the left side of your screen.Auto





Showand hide the clock.

Rightclickanemptyarea ofthe taskbar and then clickonproperty option. Awindowsopen.
From various option select and click‘show the clock’check box. It will show the clock.

To remove the clock do the same task stated above and click on the check box.

Make sure that the taskbar will be always on top.

Clickanempty area ofthetaskbarandthendragit to the desktop. Right Clickanemptyarea
of the taskbar and click on the option ‘lock the task bar’.

Make the taskbar hide. Disable the auto hide feature.

Rightclickanemptyarea ofthe taskbarand thenclickonproperty.Awindowsopen.From
various option select and click ‘Auto hide’.

To disable do the same and click again the ‘Auto hide’ option.

Create a folder BMC on the desktop.

Rightclickanemptyare of desktopthenclickonnewandthenselectfolder. Thiswill place a
new folder on desktop. Then click on name of the folder and type ‘BMC’.

Open the folder ‘BMC ‘. Maximize it and minimize it.

Select the folder and double click on the folder this will open the folder.

If this windows is not maximize bottom on top right side of the open windows.

To minimize open windows click minimize bottom on top right side of the open windows.

Maximizethefolderagain.Createa textfileBMC.TXTunder it.Restorethefoldersizemake the
folder write. Move it up and move it down.

Click at maximize bottom.

Right clicktheemptyarea ofthe folder.Clickon new,andthenclickonText Document. A
newnotepad iscreatedonthe BMC folder. Right clickonthe new notepad,and then
click on rename. Type BMC. A new text file ‘BMC TXT’ creates.

Click on ‘Restore ‘bottom on top right side of the windows.

Place the mouse pointer onthe side edge ofthe BMCfolder. It will change into double
headed arrow then hold the mouse and drag it to right hand side.

Holdthe mouse print on top of the windows thenpressed it and moves the pointer
upward and downward direction.

Create another folder NCA on the desktop.





Rightclick onempty area ofdesktopthenchoose newthenfolder. Renamethenewfolder
with MCA.

Copy the BMCTXTfile using shorthand menu from BMC to COMMERCE.

Clickontopofthe BMCfolder.Thesewillactive theBMCfolder.RightclickontheBMCTXT
file.A popup menu will come.Click on copy. Then click onMCA folder. Right clickonan
emptyspace.Apopupmenuwillcome,clickonpaste.Thiswill copyBMCTXTfromfolder to
MCA folder.

Rename the file BMCTXT as BMCLTXT.

BMCTXT as BMCLTXT.

Delete the BMCLTXT from BMC.

ClickonBMCfolder.RightclickonBMCTXT.Frompopupmenuclickdeleteoption.Adialog
boxes opens confirming the delete task. Click yes.

Create another folder BMC on desktop. Create two folders BCOM and BSC under it.

Rightclickon anempty area on desktop. From popupmenuclickonnew.Then click on
folderoption.Anewfolderiscreating.TypeBMCinfoldernamespace.DoubleclickonBMC
folder.BMCfolder isopen. Right clickan emptyarea. From popup menuclick new,then
folderoption.Anewfoldercreates.TypeBCOM.Rightclickanemptyarea ofBCOMfolder.
From popup menu click new, then folder option. A new folder creates. Type IT.

BMCTXT.

ClickonBCOMfolder.SelectBMCLTXTbyclickingit.Clickonedit frommenubar.Clickon
copyoption.Thenclick ontopoftheBMCfolder.Clickeditmenubar. Click onpaste option.

Move the file BMCTXT from BCOM to BSC using drag and drop.

Select BMCTXT by clicking it. Then click edit and then cut option. Double clickonthe BSC
folder. This will open the BSC folder. Click edit on menubar. Then click paste option from
pop down submenu. This will move BMCTXT from BCOM to BSC.

Copy the file BMCTXT from BCOM to BSCusing drag and drop by mouse bottom.

ClicktotheBMCfolder.DoubleclickonBSCfolder.BSCfolderopen.Restorethesizeofthis
foldersuchasitcanbeseenthoughfolderisopen.Thenclickonthefolder.RIGHTCLICK

popup
windowopens,thenoncopyoptiononthere.Thiswill copy BMCTXTtoBSCfolder.

Minimize all openwindows.





Clickon minimize tab on topright ofthe opening window. This will minimize the opening
window. New click on minimize tab on all open windows one by one.

Tile all thewindows vertically.

Openall the windowsby clickingontheir tabinTaskbar. Right clickan empty area of

Cascade all the openwindows.

RightclickanemptyareaofTaskbar.Apopupmenuappears.Fromvariousoptionchoose
‘cascade windows’.

Copy folders BCOM & BSC to BMC.

RightclickBCOManddragthisfolderto BMCandreleasethemousebottom.Apopupmenu
appears.Clickon‘copy here’option. Clickand dragthisfoldertoBMCand thenrelease the
mousebottom.AMENUAPPEARS.Clickon‘copyhere’option.ThiswillcopyBCOM&BSC
folders toBMC.

Delete the folder BMC from the desktop.

Closeallwindows.RightclickonBMCfolder.Apopupmenuappears.Clicksdeleteoption.A
dialogue box appears ‘confirm folder delete’. Click yes option. This will delete the folder
BMC.

Open the recycle bin and make sure that all the delete items are here.

Doubleclickonrecyclebinonthedesktop.Thiswill openrecycle bin.All the deleted items
are in the recyclebin.

Empty the recyclebin.

Click file on menu bar. Click ‘Empty Recycle Bin’.

Create a shortcut of clock on desktop. Run it.

Click on start menu bottom,click control panel. Control panel windows open. Right click on
‘Data and Time’. A popup menu appears click ‘create shortcut’. This will create a shortcut of
clockondesktop. Double click on the shortcut of clock. This will run the clock.

Change the wall paper (don’t change the stings of the desktop).

RightclickontheDesktop.Clickprosperities.Selectwallpaperoption.Fromvarious
wallpaper select one then click ‘Apply’ followed by ‘OK’.





Create a short cut ofWORDPAD on desktop. Open it and do the following task-

Type the following was speed and pastes it after the last line.

“Speedismost characteristicsofcomputer andthischaracteristicslineafterthelastline
has essentially made the computer what is today”

Center the heading and make it bold.

Replace ‘is’ with ‘was’.

Copy the firstline.

Move the second line after last line.

Save the file in your name.

Close the WARDPAD.

popupmenuappears.Click‘sendto’,apopupmenuappears,andthenclickdesktop.
This will create a shortcut on the Desktop.

Double click on the WARDPAD shortcut. Ward pad open.

Type‘SPEED’;selectthewholewardbyclicktwice.FromToolbarclickunderlineoption.
Press Enter key. Cursor moves to next line. Type ‘speed is most characteristics of
computerandthischaracteristic’.PressEnterkey.Cursormovestonextline.Type‘has
essentially made the computer what is today’.

Select ‘is’ Type‘was’.

Move the cursor left side ofthe first line. Cursor will change to a pointer,and thenclick.
This will select the first line.Right click,andthen click oncopy. Move the cursor toend of
the last line. Right click and then paste. This will copy the first line after the last line.

Selectthesecondlinerightclicksandthenclicks‘CUT’option.ThenMovethecursorto
last line. Right click and then click’ PASTE’.

ClickFileonmenubar,andthenclickoption.SAVEwindowopen.TypemynameonFile
Name and then click save button.

Click File, and then click close. This close the open WARDPAD.

Shutdown the computer.

Click STAR, Then Click Shutdown option. A window open. Click ‘SHUTDOWN’ option.





Open windows Explorer.

Rightclickon’START’menu.A popup menuwill be displayed selectExplore &click onit .

Highlight one folder and see the contents under this folder.

Onsingleclickona specificfolder,wecanhighlight a folder and cansee the contentsof
that folder on the right pane.

Use split bar to make left pane as big as possible.

Pressingleftbuttonofthe‘MOUSE’ontheSPLITBARandDRAGittotherightsideone
can be make the left PAN as big as possible.

View and off the STANDARD TOOLBAR.

Weclickonviewmenufrommenubar.Adropdownlistdisplayed.ChooseTOOLBARS
and then click on standard button. If it was OFF, Then it become on otherwise it
becomes OFF.

Show and hide STATUS BAR.

Weclickonviewmenufromthemenubaroftheexplorer.ThenchooseSTATUBAR
optionandclickonittoviewtheSTATUSBARisnotthere.Thenagainselectingview
menu from the menubar and click on it one can hide the STATUS BAR.

Off the address bar and set Explorer window as web page.

We click onviewmenufromthe menubar ofthe Explorer. Thenchoose TOOLBARS option
and then choose addressbar option&clickon itoff the addressbar ifaddressbar ison.
Choosing viewmenuand thenchoosing as webpage optionfromthe popup menu of view
we can set Explorer window as web page.

Expand the windows folder and MS-WARD application File.

from it.

Click on the HARD DRIVE and DISPLAY the details of the contents.

We clickonthe‘HARDDRIVE’ likeC:,D: orE: Wecansee thename&iconofthat drive and
all folders and files which that particular drive holds.

Sort the FOLDERCONTANTasthe ASSSENDING ORDEROFNAME.

We choose viewmenufrommenubar.Thenchoose arrange iconfromthe dropdown
list and finally click on by name option from the submenu.





Sort the folder contents in the DESCENDING ORDER OFTYPE.

First, We select a folder from the folder pan. Thenfrom view menuof the menu bar. We
choose arrange icon and click on the by option. We cansort the contentsofthat folder
on DESCENDING ORDER OF TYPE.

Sort the folder content in the descending order of last modified.

First, We select a folder form the folder pan. Then from view menu of the bar. We
choose arrangeiconand thenwe clickon bydate option. We can sort the contents of
that folder on descending order of last modified date.

Expand all branch of HARD DISK.

Double- clicked (L) on the HARD DISK PARTITIONS.

Click onthe CLOSEOPTION.

Create a folder BMC under root (HARD DISK).

Select DRIVE(C:)from explorerleftpane whichshowsthecontentsofC: onthe right
pane right, click anywise onthe right paneexcept onany otherfile or folder it showsa
popup menu from. We have to choose new and thenfolder from the submenuofthe
new. So a new folder is created and we give its name BMC.

Open the folderBMC.

To open folder BMC, we select the BMC FOLDER from the folder pan of explorer.

Create a text file BMC. TXT under it.

First,we openthe folder BMC and then right click`anywhere on the right pane and then
we select the text document & we give it the name BMCTXT.

Make the file BMC TXT HIDDEN.

Open the folder BMC. Then right click on BMC TXTFILE, It shows a popup menu from
which be have to choose properties and then hide option from its attribute and then
apply.

SHOW ITAGAIN.

Select BMCTXTfrom the BMCfolder, right click onIT& choose puppetryoptionfrom the
popup menu and click on it. If there is a right mark on the hidden attribute then click on it
to make it mark free and click on apply.

Create another folder BCOM under ROOT.

Select C: fromthe left panofthe explorer. Right clickany ware on the right pan except
onany folder or file. IT showsa popup menufrom whichwe have to choose new and





then folder from the submenu of the new. So a new folder is created and we give it the
name BCOM.

Copy the BCOM TXTFILE using shorthand menu from BMC to BCOM.

WeselectBMCfolder.ThenselectBMCTXTpressingleftmousebuttononitandalso
passing control key simultaneously& we dragit to the folder BCOM inthe left pane. It will
copy BMC TXT from folder BMC to BCOM.

Rename the file BMC. TXT as BMC TXT.

WeselectBMCfolder.ThenrightclickonBMC.TXT,wechooserenameoptionfromthe
popup menu and we gi9ve it the name BMC TXT.

Delete the file BMC TXT from BMC.

Todelete thefile BMCTXTfromBMCfirst,Weright clickonBMCTXTandthenweclick
on delete option from the popup menu.

Createanother folder BTECHonDESKTOP.CreatetwofoldersCSEandITunderIT.

We select desktopfrom explorer folder pane.Right clickonany ware onthe right pane
except on any folder or file.Choose newoptionfrom the popup menu andthenclickon
folderandwegiveitnameBTECHtocreatetwofoldersinBTECH,FirstweselectBTECH
from left explorer pane & then we right click in the blank space of the right pane. A
popup menu is displayed,from whichwe clickthe newfolder option. Soa newfolder is
created,twowhich we give the name casesinthe same way we create another folder
named it under folder BTECH.

CopythefileBMCTXTfromBCOMtoBSCusingmenuandrenameasBCOMBMCTXT.

WeopenBCOMfolder.ThenweselectBSCTXTfromtherightpane.Fromeditmenuwe
choose copyoption.Thenwe openBSCfrom desktop. Againfromeditmenuweclick
paste optionto renameit rightclickon BMC TXT,we click rename option and we giveit
the name BMCTXT.

Move the file BMC TXT from BSC to BCOM using drag drop method.

We openBMCfolder and theselect BMCTXT.Thenweleft clickonthefile& pressing
the left mouse button we drag it from folder BSC to the BCOM folder & release the left
mouse button.

Copy the file BNC TXTfrom BCOMtoBSC using drag and dropby right mousebutton.

OpenthefolderBCOMpressrightmousebuttononBMCTXTdragBCOMandwhenwe
release the buttonit shows a popup menufrom which we select copy here option.

Copy any four consecutive files to BMC.





Selectedthefour filesby pressing shift +arrowkey and thenperformedthegeneral
copy-paste operation.

Copy any four non consecutive file to BCOM folder.

We openany folder having more than four files then we left clickon any file, thenwe
press the control button from the keyboard & keeping it pressed. We select other there
nonconsecutive files then,we release the control button and then, we pressthe ctrl & c
buttons simultaneously. Then we open the BCOM folder & press ctrl+v.

Delete the folder.

We select BMC folder. From file menu we click delete.

Close the WindowsExplorer.

We select File menu and then click on close option from it.

ASSIGNMENT-1

Save the file into the 1 year directory:

Make1yeardirectoryintoCdrive.File->Saveas->1yeardirectory-Assignment 1

(File name). Doc -> Save.

Change the left and right margin according to your choice using mouse:

Select all the text by pressing Ctrl + A. Click onleft alignsofformattingtoolbar for
left Alignment.

Click on right align of Formatting toolbar for right alignment.

Selectspecifiedlinesbymousedragging.ThenpressCtrl+C.Thenpasteattheend of
the document by pressing Ctrl + V.

Move the second paragraph to the of the document:

Selectsecondparagraph& pressCtrl +X.Thenpasteattheendofthedocumentby
pressing Ctrl +V.

Make whole document bold:

Press Ctrl + A. Click on Bold button (B) of Formatting toolbar.

Turn off the ruler. Again turn on:

View-->Click on Ruler to turn off.

View-->ClickonRulertoturnon.





Turn off the standard toolbar and turn on the border toolbar:

View -->Toolbars-->Click on standard toolbar.

Format-->border and shading-->Border-->Show toolbar-->OK.
Change the font of the whole document to courier and make its size.

Former -->Font -->Font-->selectcourier.
Format -->Font-->Size-->Select 14.
OK.

Hide the name Ted Lee:

On the Format menu, click Font, and then click the Font tab.

Select the Hidden check box.

10. Make all the characters of the first paragraph to capital:

On the Format menu, click Font, and then click the Font tab.

Select the All caps check box.

Save the document in the 1 year directory with different name:

Quit from

world: Press Alt +

F4.

ASSINGNMENT II

Open the previously created document.

Toopenthe previously createddocument,we gotostart,Programs,MS Word.
WhenMS Wordopens,wegotto Filemenu,Open.Adialogboxopenswhere we
choose the drive, the folder where the document is located and click on the
‘Open’ button. The required document opens.

WegotoEdit,Findandclick.The word tobesearched isaskedfor.Wetype
“Awards” .The word gets highlighted in the document.

Replace all the “Corson “with “Carson”.

We goto Edit,Findandclick onthe Replacetab.Thewordtobereplacedand
thewordtoreplace it withare askedfor.We enter “Curzon”and “CARSON”in
therespectiveplacesandclickonthe ‘Replace All’button.All the“Curzon”get
replaced with“Carson’s”.





Create a bookmark according to your choice.

We select anitem we want a bookmark assigned to,or clickwhere we want to
insertabookmark.Ontheinsertmenu,clickbookmark.UnderBookmarkname,
type or select a name. Click Add.

Insert a page break after the first paragraph.

Clickafterthefirstparagraph,gotoinsertmenu,Break,ChoosePageBreakand
click ‘OK’.

Move your control to the first page of the document.

Clickthe Edit menu,Go,To. Awindowopenswhereweselect pageandtype in
thepagenumberinthespaceprovided. ClickGo,To .The control moves tofirst
page of thedocument.

Click t6he Edit menu,Go,to.A windowopenswhere we select line and typein the
linenumberinthespaceprovided. Click GoTo.Thecontrol moves tothe 7th line
of thedocument.

Insert the page number to the current document. Omit the first page number.

ClicktheInsertmenu,PageNumber;specifythepositionandalignmentandclick
‘OK’. Pagenumberisinserted.Againgo toinsertmenu,Page Numberclickthe
option ‘show number on first page’ to unpick it and click ‘OK’. The first page
number is omitted.

Increase the space between the characters.

Select the text you want to change.Onthe Format menu,click Font,and then
clicktheCharacterSpacingtab.Dooneofthefollowing:-Toexpandorcondense

in
theSpacing box,and thenspecify howmuch space you want in the bybox.

Change the line spacing between the paragraphs.

Selecttheparagraphsinwhichyouwanttochangelinespacingorparagraph
spacing.OntheFormatmenu,clickParagraph,andthenclicktheindentsand
Spacingtab.Underspacing,dooneofthefollowing:-Tochangelinespacing,
select the optionyouwant inthe line spacing box. Toadd spacingbefore or
after cashparagraph,enter the spacing you want in the before or after box.





Insert tab into your document according to your choice to make your document
goodlooking:- Select the paragraphinwhichyouwant to set a tabstop. Click at
the Fr left of the horizontal ruler until it changes to the type of set you want.
Click the horizontal ruler where you want to set a tab stop.

Insert a border into your document to write something as notes.

Move to the 3rd line of record page and change that particular line to upper case

Click Edit menu,Go To,selectline, typein3 inthe line numberspace and click on
the‘goto‘button.Thenclick onFormatmenu,Font andchoosethe‘All Caps’
option. Then click‘OK’.

Create a newdocument.

GoTo,Filemenu,New,selectbankdocument,andclick‘OK’.Anewdocument
will be created.

Type the assignment as inserting the bullets or numbering in the document.

To insert bullets, go to Format menu, Bullets and Numbering. To insert billers,
select the billers tab, select the bullet and click ‘OK’. To insert numbers, select
the numberstab, choose the type of numbering scheme and click‘OK’.

Check the spelling of your document with the word’s spell check.

Tocheckthespellingofa document,gotoToolsmenuSpellingsandgrammar.
The wrong spellingsappearin a window.Either click ‘Ignore’ to do nothingto
themor click‘Change’to changetothewordsuggestedbyWord.After doing
this, click‘OK’.

Display the drawing toolbar. Create a text boxand a call out for writing
something in the box. To displaythe drawingtoolbar,goto the View menu and
goto Tools. Under Tools,click ‘drawing’.Thedrawing toolbar appearson the
screen.To create textbox,choose textboxonthe drawing toolbar and draw a
box on the screen with its help. Write in the space provided.

Using Auto correct protect your spelling mistake.

Touseauto correct,gotoToolsmenu,Auto Correct.Awindowcontainingfour
tabsopens. In each of the tabs,select the nicety optionsand click ‘OK’.

Make a toolbar according to your need through which you can create a new
document. Open an existing document. Save the document, Cut, Copy, Paste,
Bold, Italic, Underline, Outside border, Line draw, Rectangle draw. Close all the
toolbars and then open your created toolbar.

OntheToolmenu,clickCustomize,andthenclickthenclickthe Toolbarstab.
Click new. In the Toolbar name box,type the name you want. In the make
toolbar available to box,clickthe template or document you want to save the





toolbarsin. Leave theCustomize dialogboxopen(youmight need tomove itout
ofthe way), and do one or more of the following:-To add button to the toolbar,
click the commands tab. In the categories box, click a category fort the
command. Drag the command you want from the commands boxtothe toolbar.
To adda built- inmenu tothe toolbar,click the commandstab. Inthe categories
box, click Built- in Menus. Drag the menuyou want fromthe commands boxto
the toolbar. When you have added all the buttons and menus you want, click
Close. Close other toolbars and open the newly created toolbar.

Insert Header and Footer into your document. Display the Header and Footer.
Make different first page header:- To insert and footer, go to View menu,
Header and Footer.A space appearsfor the header,write the header init. Inthe
headerandfooter window,chooseanyone amongst the many optionavailable
like Date and Time,Page numberetc.and applyit. The header and footer are
displayed.ToMAKEDifferentfirstpage header,gotoHeaderandFooterunder
Viewmenu,selectpage setup,clicktheLayouttab,clicktheDifferentFirstPage
Header to tick it and click ‘OK’.

Create a new document in a two columnar from .

Open a new document, write something in it, and switch to the print Layout
view.Clickwherenewcolumnis to start.Onthe insert menu, clickBreak. Click
column break. Word moves the text that follows the insertion point to the top of
the next column.

Protect the document from illegal users.

A document canbe protectedfromillegal usersby giving ita password. Todo
this,openthedocument. Onthe Filemenu,clicksavesas. Onthe toolsmenuin
thesave as dialog box,clickgeneral option.Inthepassword toopenbox,type a
password,and then click OK .In the reenter password to openbox, type the
password again, and then click OK. Click Save.


